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                                                                                1 How to create PDF maps, pdf layer maps and pdf maps with attributes using ArcGIS Lynne W Fielding, GISP Town of Westwood PDF maps are a very handy way to share your information with the public as well as coworkers. They can also be a way to share more detailed GIS information with people in the field without them touching the live GIS. This allows people to work with GIS information without being forced to purchase expensive software or learning how to use complicated software. This tutorial explains not only the basics of creating pdf maps but also creating map books or atlases and then exporting to pdf simple maps as well as those that allow layers to be turned on/off and also attributes. Basics Using ArcGIS software you can save maps to PDF using File -> Export Map There are many format options to choose from, but for this discussion we re using pdf Lynne Fielding, GISP Page 1 6/18/2009
                                            










                                            2 It s always good to make the name simple, but including a year or date is good, especially if you plan to update or put on the web. If you re going to put a file on the web the smaller the file the better, however, be sure you don t make a file with so low a resolution that it s pixelated. On the other hand, if you make it high resolution it may not be suitable to be on the web. Either way, if you have Adobe Acrobat it s a good idea to use the Reduce File Size function, which will do a good job of making the file size smaller without ruining the quality of the map (NB: exceptions being the layer and attribute PDFs) If you have Adobe Acrobat on your computer you could also create a pdf using the print function. Choose File-> Print -> then in the printer choice pick Adobe PDf or Distiller, depending on the version you have. You re then asked for a location and file name to save as. This can be used with most any software or documents from the web. Lynne Fielding, GISP Page 2 6/18/2009
                                            

                                            3 Sets of maps, mapbooks, or atlases From the most basic annual update of Assessor maps to the most imaginative set you can come up with, creating a set of maps is pretty simple now if you use DSmapbook, which is available as a free download from ESRI. The hyperlink will take you directly to the download Once you install the application you should have an additional Map Book tab below your Table of Contents as shown below The basic requirement to set up a map series will be a layer to use for the grid (that will be used for the template of each page). This grid requires a STRING field to be used to define the page, which may also be used to number each page. If you don t have this field in your attribute table then add a field that you format as a STRING and insert the grid names. You should be sure you have this layer before you go on. Hints: - if you use numbers then start with 01 instead of 1 or they ll be listed out of order when you export. - if your grid (or any other layer) has a cryptic name then rename it in the Table of Contents BEFORE you set up the series. This will be more important in future examples Work in Layout View and set up the page layout first. For maps that will go to a wide audience 11 x 17 is a good size since they can be shrunk to print on 8.5 x 11 paper and still be detailed when printed. But use whatever size you need. Lynne Fielding, GISP Page 3 6/18/2009
                                            

                                            4 Setting up the Series: 1) Click on the Map Book tab. It should look similar to the example below. 2) Right-click on Map Book and Click Add Map Series The following window will pop up Lynne Fielding, GISP Page 4 6/18/2009
                                            

                                            5 Notice in the default window that it already picked out my grid layer and the correct STRING field. Also, the index layer lists Map Grid although my layer is actually called assrgrid, because I renamed it. If you rename this afterwards you will get an error in your series If the default information is correct then choose Next. The next window should be defaults unless you have a map page that needs removing for some reason This next window will allow you to set up the scale as well as a few other options. If they can all be the same scale then just enter that in the Fixed Extent. If you have a series that should have variable scales you can use the Data driven option, which would require you to create a field in the grid layer where you d enter the scale for each grid. Lynne Fielding, GISP Page 5 6/18/2009
                                            

                                            6 Other options exist in this window. Label neighboring tiles can be useful but looks a little messy. Try these options yourself. Click Finish when you have set your scale. Your series should have been created and be listed in the Table of Contents. At this point you won t see any change in the layout window until you double-click one of the pages listed on the left. Lynne Fielding, GISP Page 6 6/18/2009
                                            

                                            7 But since no labels were included when this was set up we have no way to know which map this is, and we don t know if the scale will work to make that grid fit this page (which it doesn t). So we ll go back and make a couple of changes. First, click the Display tab and label the Map Grid layer Next, go back to the Map Book tab and right-click Map Series and choose Series Properties Lynne Fielding, GISP Page 7 6/18/2009
                                            

                                            8 Click the Options tab and tweak the scale until it works for you. (I ve chosen this scale because I know it works for this example and I don t need a standard scale) Once you have clicked OK, go back to any page in the series and double-click to update it. You ll see you now have the grid showing (in red), so you know that scale works for your page size. Using this method (of showing the grid) allows a user to see that they have additional Lynne Fielding, GISP Page 8 6/18/2009
                                            

                                            9 options to view the same parcel (for example) since it will also show on the adjacent maps. In many cases this is a good idea. The above example is pretty plain and also demonstrates potential labeling issues. Here s an alternative. You can create a page # that will get picked up by your series. Let s set one up. Click the New Text option of the Drawing toolbar and click to insert on your map page. With the text still highlighted right-click on Map Series and choose Tag as Page Number Lynne Fielding, GISP Page 9 6/18/2009
                                            

                                            10 The text box changes, and if we turn off the labeling on the Grid layer and then double-click the page number to refresh it now gives you the page number. If you look back at that list you ll see there are several other options you can use with text, including the date, which is very handy if you need to keep tabs on revisions. Another handy tool is on the Map Series toolbar. It s called the Page Identifier and gives two options (I like to use them both) Once you click OK you need to draw a rectangle on your layout where you d like this to be. Lynne Fielding, GISP Page 10 6/18/2009
                                            

                                            11 In the Display tab of the Table of Contents you now have an additional data frame. It s useful to add your map outline to this too. After you refresh the page (as before) it will show you where in the grid layer you are. Here we show both global and local after adding the town line. The previous page number has been set in the rectangle of the global and in the local the grid numbering has been applied. The local identifier seems to be a much cleaner way to label your grids and avoids covering information on your actual map. You can make these as simple or as fancy as you like, but I ve found that in addition to the series, creating an Index page that possibly includes a street list (to be used as a cover) is very handy and the clickable section will explain further. Incidentally, you can export the series Lynne Fielding, GISP Page 11 6/18/2009
                                            

                                            12 index (in this case a street index listing) automatically from Map Book. It creates a text file that shows all grids the street appears in. I then copy sections of the list back onto the index page to where I want it using whatever font and size I want. It s nice to then make this clickable. One other thing that came back to me as a suggestion was to create a separate large font (regular size) listing (using the same text file) that I add to the back of the atlas for those who can t read the font on the index page. Lynne Fielding, GISP Page 12 6/18/2009
                                            

                                            13 To export your map series simply right-click on Map series and click Export Series change the jpeg to pdf and set the resolution appropriately. Create a folder to place the maps and for name just simply map or page then Save and OK The maps will be given the prefix of the name you gave followed by the name in the STRING field. The window will close after all maps are exported. The maps can be combined into a single pdf file if desired by using Adobe Acrobat Creating maps with layers This can be done as simple maps or as map series and can only be done if you have ArcGIS 9.2 or newer. In 9.2 this happens by default when you export your pdf files they will have the layers available. At 9.3 you have the option to export with or without layers (see below). If you decide you don t want the layers available you can use Adobe Acrobat and use the Reduce File Lynne Fielding, GISP Page 13 6/18/2009
                                            

                                            14 Size option. This will flatten the map and remove the ability to see separate layers. We ll discuss the Export PDF Layers and Feature attributes later One of the challenges with the layer versions is that some of the layers may be combined so that the separate layers aren t available. This can usually be resolved by rearranging the layer stack on the ArcGIS side of things. This sometimes takes a few attempts but usually worth the effort. Renaming cryptic layers in the Table of Contents will save you a lot of extra work as was done with the following map Lynne Fielding, GISP Page 14 6/18/2009
                                            

                                            15 The file is then viewed using FREE Adobe Reader (this is version 9) that can be downloaded from Adobe.com The red arrow shown (above left) indicates that there are layers in this pdf, and by clicking this icon you can see what they are (sometimes a + needs to be opened). The list of Layers is almost identical to the list in the ArcGIS layout. By clicking on the eye shown by the arrow (above right) layers may be turned on/off. This can then be used to control printing Lynne Fielding, GISP Page 15 6/18/2009
                                            

                                            16 With some layers turned off we have then zoomed into a smaller area. In the Print window we then set the properties so that we can print just a small portion of our map with only those layers we chose and set to fill a letter-sized page. We could then go back and turn on/off other layers using the same extent and print again for comparison. Lynne Fielding, GISP Page 16 6/18/2009
                                            

                                            17 Layers & atlases Let s consider doing the same process in a multi-page atlas. The example below shows that the selected page layers are listed in bold at the left. An alternative would be to only display the layers for the visible page, which would be easier to keep track of. Lynne Fielding, GISP Page 17 6/18/2009
                                            

                                            18 Turning layers on/off works the same but you need to be a bit more careful in setting up the printing of a selection from one page. Again being sure to check the Current View / Current page rather than All Lynne Fielding, GISP Page 18 6/18/2009
                                            

                                            19 PDFs with GIS attributes The ability to export GIS attributes came with ArcGIS 9.3 but you should go to ESRI and download the PDF patch:   aid=1407 You also need to download Adobe Reader 9 (FREE) Once you have the patch installed you can do more than just export attributes with your pdf, but read ESRIs page for that. First we ll go with our simple one-page layout we had before. We won t change anything else on the ArcGIS side and see what happens Lynne Fielding, GISP Page 19 6/18/2009
                                            

                                            20 The same layer information is there and nothing else has changed that we can tell. We need a new toolbar in Adobe Reader. The Analysis toolbar This toolbar (as shown below) allows you to get information that has been exported with the PDF. The other tool allows you to get lat-long info but that s not the current topic If I click on this tool and then click on the parcels this is what happens I ve opened the + in front of Layers, in the next step I ll open one of the actual layers Lynne Fielding, GISP Page 20 6/18/2009
                                            

                                            21 Everything appears to be selected (in red) and a Model Tree window has opened at the left. Below I ve clicked open Bldg Footprint then clicked on any one of them. In the bottom window all the attributes I allowed to be exported are available for ANYONE to see. Obviously this is more data than I want out there. In addition, from the way the addresses are shown in the list I have no way of telling what the address is until I click one. We need to fix these things in ArcGIS Lynne Fielding, GISP Page 21 6/18/2009
22 ESRI recommends you only allow attributes from ONE layer to be exported let s at least do two, but we ll turn some fields off that aren t useful. First we ll deal with parcels. We use the Primary Display field to set what s shown in that first list. Then we uncheck all fields we don t want data available for. Even the field names won t show in the pdf when we ve finished. Here s what it looks like after Lynne Fielding, GISP Page 22 6/18/2009
23 Much easier to find and more relevant information shown. Lynne Fielding, GISP Page 23 6/18/2009
24 Let s change parcels. We ve set their primary field to the LOTID (parcel ID) so that it s not the same as the buildings. Notice the selected parcel is highlighted using the color shown above the list. By right-clicking you can also elect to zoom to that parcel. Below left are the attributes allowed from the GIS Lynne Fielding, GISP Page 24 6/18/2009
25 Setting up the clickable bits in Adobe Acrobat You ll need to have Adobe Acrobat to do this (although there may be other products out there that can do it). Versions as old as 6.0 can create the clickable links. A few things to remember before you set up any clickable products 1) If this is going to be a product you reuse or update, then make sure the layout works for you. The ones I currently use are the result of trial and error. 2) Consider the layout size (if a map). 3) Consider the file size (especially if you want to put this on the web) 4) For web products keep it self-contained 5) If larger files (as with layer &/or attribute maps) keep separate 6) If you re linking several external files put them in folder(s) at the same level as your pdf. Links are relative and this will make the final product easier to share. How to create basic (internal) links First I ll use examples that make an assessor atlas easier for everyone to use. I have created an Index page that shows the entire town, the assessor map grid and all the streets. This has been combined into a single pdf. The figure below shows how this looks if I turn on the page thumbnails while displaying the Index page. This atlas already has the clickable bits set up. You can set the links with a visible/invisble box. I ve set these to be invisible. On this page each street name and each grid box is set as a link. The street name will take you to the first page listed for that street zoomed to the best extent of Lynne Fielding, GISP Page 25 6/18/2009
26 that street. To see the links you need to turn on the Advanced Editing toolbar. This may look different in your version but the tool is similar. Here I ve undocked the toolbar and selected the linking tool (looks like a chain), which now reveals the items that have links on this page. Lynne Fielding, GISP Page 26 6/18/2009
27 You can tell when something has a link by using the hand tool When you hold the hand tool over the pdf it changes to a pointer if it s clickable (there s a link). On the other pages in this atlas the clickable parts are on the local and global indicators, which you remember we set up earlier. On all pages the global link takes you back to the Index page. The local links have been set up so that there is a link on each numbered box so that you can click any numbered box to go to that page. These are the adjacent maps to the current one. When updating the series then I change the date, color of banners and maybe local indicator background so it appears slightly different, but then when pages are replaced the clickable bits are already there so it s minimal work. So how do we set a new link? We ll redo one of the global links that take you back to the Index page. Click on the link tool (chain). When you move over the pdf you now see cross-hairs. Use these to draw a box where you want to make a link. After you ve drawn the box the following window pops up. For this we want to Go to a page view and make the box invisible. Click Next The next step is to choose the page (or extent) you want to link to. Lynne Fielding, GISP Page 27 6/18/2009
28 Don t click the Set Link until you change to the location or view you want. In this case we want the Index page. We can use the thumbnail to get that page and in this case we want the full page so we ll zoom back out to that view (I keep that icon and several other useful ones on the toolbar) As soon as you click the Set Link it will return to the page where you were setting the link. With the link tool still active you notice the link box has changed from solid color to just the handles having color. Lynne Fielding, GISP Page 28 6/18/2009
29 Change to the hand tool and test your link. It ll be easier to return to the link page if you have the Previous button on your toolbar. This and other buttons can be set out using Tools -> Customize In the previous example, if you d wanted to show just part of the page (as in a single street) you would zoom in to that area before you click the Set Link Similarly, if you wanted to link to a file or a web page you can set those links the same way. Again, if you have many files you want to link it s better to have them contained in a folder or folders, especially if you intend to share them. Lynne Fielding, GISP Page 29 6/18/2009
                                    
                                
                                
                            



                            
                            
                                                                    
                                        
                                        
                                        
                                        
                                    

                                
                                
                                    
                                        Similar documents
                                        
                                    
                                

                                

    
        Tips & Tricks for ArcGIS. Presented by: Jim Mallard, Crime Analysis Supervisor Arlington, Texas. 2007 IACA Conference Pasadena, Ca
    

    
        
        Tips & Tricks for ArcGIS Presented by: Jim Mallard, Crime Analysis Supervisor Arlington, Texas 2007 IACA Conference Pasadena, Ca Table of Contents Lock & Load Labels for Maximum Speed!...2 Choose your    

    
        More information 
    




    
        Acrobat PDF Forms - Part 2
    

    
        
        Acrobat PDF Forms - Part 2 PDF Form Fields In this lesson, you will be given a file named Information Request Form that can be used in either Word 2003 or Word 2007. This lesson will guide you through    

    
        More information 
    




    
        Maplex Tutorial. Copyright 1995-2010 Esri All rights reserved.
    

    
        
        Copyright 1995-2010 Esri All rights reserved. Table of Contents Introduction to the Maplex tutorial............................ 3 Exercise 1: Enabling Maplex for ArcGIS and adding the Labeling toolbar............    

    
        More information 
    




    
        So you want to create an Email a Friend action
    

    
        
        So you want to create an Email a Friend action This help file will take you through all the steps on how to create a simple and effective email a friend action. It doesn t cover the advanced features;    

    
        More information 
    




    
        If you know exactly how you want your business forms to look and don t mind
    

    
        
        appendix e Advanced Form Customization If you know exactly how you want your business forms to look and don t mind detail work, you can configure QuickBooks forms however you want. With QuickBooks Layout    

    
        More information 
    




    
        INTRODUCTION to ESRI ARCGIS For Visualization, CPSC 178
    

    
        
        INTRODUCTION to ESRI ARCGIS For Visualization, CPSC 178 1) Navigate to the C:/temp folder 2) Make a directory using your initials. 3) Use your web browser to navigate to www.library.yale.edu/mapcoll/ and    

    
        More information 
    




    
        ADOBE ACROBAT 7.0 CREATING FORMS
    

    
        
        ADOBE ACROBAT 7.0 CREATING FORMS ADOBE ACROBAT 7.0: CREATING FORMS ADOBE ACROBAT 7.0: CREATING FORMS...2 Getting Started...2 Creating the Adobe Form...3 To insert a Text Field...3 To insert a Check Box/Radio    

    
        More information 
    




    
        TABLE OF CONTENTS SURUDESIGNER YEARBOOK TUTORIAL. IMPORTANT: How to search this Tutorial for the exact topic you need.
    

    
        
        SURUDESIGNER YEARBOOK TUTORIAL TABLE OF CONTENTS INTRODUCTION Download, Layout, Getting Started... p. 1-5 COVER/FRONT PAGE Text, Text Editing, Adding Images, Background... p. 6-11 CLASS PAGE Layout, Photo    

    
        More information 
    




    
        Handout: Word 2010 Tips and Shortcuts
    

    
        
        Word 2010: Tips and Shortcuts Table of Contents EXPORT A CUSTOMIZED QUICK ACCESS TOOLBAR... 2 IMPORT A CUSTOMIZED QUICK ACCESS TOOLBAR... 2 USE THE FORMAT PAINTER... 3 REPEAT THE LAST ACTION... 3 SHOW    

    
        More information 
    




    
        ADOBE DREAMWEAVER CS3 TUTORIAL
    

    
        
        ADOBE DREAMWEAVER CS3 TUTORIAL 1 TABLE OF CONTENTS I. GETTING S TARTED... 2 II. CREATING A WEBPAGE... 2 III. DESIGN AND LAYOUT... 3 IV. INSERTING AND USING TABLES... 4 A. WHY USE TABLES... 4 B. HOW TO    

    
        More information 
    




    
        Adobe Dreamweaver CC 14 Tutorial
    

    
        
        Adobe Dreamweaver CC 14 Tutorial GETTING STARTED This tutorial focuses on the basic steps involved in creating an attractive, functional website. In using this tutorial you will learn to design a site    

    
        More information 
    




    
        Web GIS User Guide MainStreetGIS, LLC
    

    
        
        Web GIS User Guide MainStreetGIS, LLC www.mainstreetgis.com Navigation There are two ways to navigate the map interface: 1. Activate one of the map tools a. Zoom In Tool Activate the tool, then click on    

    
        More information 
    




    
        Chapter 14: Links. Types of Links. 1 Chapter 14: Links
    

    
        
        1 Unlike a word processor, the pages that you create for a website do not really have any order. You can create as many pages as you like, in any order that you like. The way your website is arranged and    

    
        More information 
    




    
        How to Make the Most of Excel Spreadsheets
    

    
        
        How to Make the Most of Excel Spreadsheets Analyzing data is often easier when it s in an Excel spreadsheet rather than a PDF for example, you can filter to view just a particular grade, sort to view which    

    
        More information 
    




    
        Microsoft Office 2013
    

    
        
        Student manuals available at: www.learnit.com/manuals Username: manuals; Password: password Microsoft Office 2013 New Features Take this class home with you! Student Videos Available at: www.learnitanytime.com    

    
        More information 
    




    
        CREATING YOUR OWN PROFESSIONAL WEBSITE
    

    
        
        First go to Google s main page (www.google.com). If you don t already have a Gmail account you will need one to continue. Click on the Gmail link and continue. 1 Go ahead and sign in if you already have    

    
        More information 
    




    
        WINDOWS LIVE MAIL FEATURES
    

    
        
        WINDOWS LIVE MAIL Windows Live Mail brings a free, full-featured email program to Windows XP, Windows Vista and Windows 7 users. It combines in one package the best that both Outlook Express and Windows    

    
        More information 
    




    
        Microsoft Expression Web
    

    
        
        Microsoft Expression Web Microsoft Expression Web is the new program from Microsoft to replace Frontpage as a website editing program. While the layout has changed, it still functions much the same as    

    
        More information 
    




    
        Creating Hyperlinks & Buttons InDesign CS6
    

    
        
        Creating Hyperlinks & Buttons Adobe DPS, InDesign CS6 1 Creating Hyperlinks & Buttons InDesign CS6 Hyperlinks panel overview You can create hyperlinks so that when you export to Adobe PDF or SWF in InDesign,    

    
        More information 
    




    
        Create a report with formatting, headings, page numbers and table of contents
    

    
        
        Create a report with formatting, headings, numbers and table of contents MS Office Word 2010 Combine this model with instructions from your teacher and your report will be something you can be proud of.    

    
        More information 
    




    
        Creating Interactive PDF Forms
    

    
        
        Creating Interactive PDF Forms Using Adobe Acrobat X Pro Information Technology Services Outreach and Distance Learning Technologies Copyright 2012 KSU Department of Information Technology Services This    

    
        More information 
    




    
        DCAD Website Instruction Manual
    

    
        
        DCAD Website Instruction Manual - 1-9/1/2010 INDEX PAGE Search Appraisal ---------------------------- 3-4 Owner Name ------------------------------ 5-6 Account Number ------------------------------ 7 Street    

    
        More information 
    




    
        Microsoft Migrating to PowerPoint 2010 from PowerPoint 2003
    

    
        
        In This Guide Microsoft PowerPoint 2010 looks very different, so we created this guide to help you minimize the learning curve. Read on to learn key parts of the new interface, discover free PowerPoint    

    
        More information 
    




    
        Making TIFF and EPS files from Drawing, Word Processing, PowerPoint and Graphing Programs
    

    
        
        Making TIFF and EPS files from Drawing, Word Processing, PowerPoint and Graphing Programs In the worlds of electronic publishing and video production programs, the need for TIFF or EPS formatted files    

    
        More information 
    




    
        ArcGIS Tutorial: Adding Attribute Data
    

    
        
        ArcGIS Tutorial: Adding Attribute Data Introduction A common need in GIS is to map characteristics, or attributes, of different geographic areas. These maps are called thematic maps. Examples of thematic    

    
        More information 
    




    
        Working with SmartArt
    

    
        
        CHAPTER Working with SmartArt In this chapter by Geetesh Bajaj Understanding SmartArt 206 Adding SmartArt to a Presentation 206 Formatting SmartArt 208 Sample SmartArt Variants 211 Common SmartArt Procedures    

    
        More information 
    




    
        TUTORIAL 4 Building a Navigation Bar with Fireworks
    

    
        
        TUTORIAL 4 Building a Navigation Bar with Fireworks This tutorial shows you how to build a Macromedia Fireworks MX 2004 navigation bar that you can use on multiple pages of your website. A navigation bar    

    
        More information 
    




    
        Florence School District #1
    

    
        
        Florence School District #1 Module 2: SMART Board Basics and Beyond 1 SMART Board Software and Beyond In SMART Notebook software, you can create or open SMART Notebook software (.notebook) files. After    

    
        More information 
    




    
        PE Content and Methods Create a Website Portfolio using MS Word
    

    
        
        PE Content and Methods Create a Website Portfolio using MS Word Contents Here s what you will be creating:... 2 Before you start, do this first:... 2 Creating a Home Page... 3 Adding a Background Color    

    
        More information 
    




    
        ITCS QUICK REFERENCE GUIDE: EXPRESSION WEB SITE
    

    
        
        Create a One-Page Website Using Microsoft Expression Web This tutorial uses Microsoft Expression Web 3 Part 1. Create the Site on your computer Create a folder in My Documents to house the Web files. Save    

    
        More information 
    




    
        MAKE YOUR FIRST A-MAZE-ING GAME IN GAME MAKER 7
    

    
        
        MAKE YOUR FIRST A-MAZE-ING GAME IN GAME MAKER 7 In this tutorial, you will learn how to create your first game in Game Maker. The game you will create will be a simple maze game. The object of the game    

    
        More information 
    




    
        Knowledge Base for Electronic Editing Tools
    

    
        
        2014 Knowledge Base for Electronic Editing Tools JOSHUA BLOUNT CAMMY HERMAN JOHN DRISCOLL TEXAS TECH UNIVERSITY 1 This document collects a series of tutorials designed to help editors get the most out    

    
        More information 
    




    
        CREATE A WEB PAGE WITH LINKS TO DOCUMENTS USING MICROSOFT WORD 2007
    

    
        
        CREATE A WEB PAGE WITH LINKS TO DOCUMENTS USING MICROSOFT WORD 2007 For Denise Harrison s College Writing Course students Table of Contents Before you Start: Create documents, Create a Folder, Save documents    

    
        More information 
    




    
        Action settings and interactivity
    

    
        
        Interactivity in Powerpoint Powerpoint includes a small set of actions that can be set to occur when the user clicks, or simply moves the cursor over an object. These actions consist of links to other    

    
        More information 
    




    
        Getting Started with WebSite Tonight
    

    
        
        Getting Started with WebSite Tonight WebSite Tonight Getting Started Guide Version 3.0 (12.2010) Copyright 2010. All rights reserved. Distribution of this work or derivative of this work is prohibited    

    
        More information 
    




    
        Task Card #2 SMART Board: Notebook
    

    
        
        Task Card #2 SMART Board: Notebook Objectives: Participants will learn how to utilize the SMART Notebook. Table of Contents: Launching The SMART Notebook Page 1 Entering Text Page 1 Top Toolbar Page 2    

    
        More information 
    




    
        Using FileMaker Pro with Microsoft Office
    

    
        
        Hands-on Guide Using FileMaker Pro with Microsoft Office Making FileMaker Pro Your Office Companion page 1 Table of Contents Introduction... 3 Before You Get Started... 4 Sharing Data between FileMaker    

    
        More information 
    




    
        TxDMV RTS Training Guide for Working with Cognos Reports
    

    
        
        TxDMV RTS Training Guide for Working with Cognos Reports April, 2015 About This Guide This Training Guide introduces the implementation of the Cognos enterprise reporting tool for the TxDMV Registration    

    
        More information 
    




    
        Migrating to Excel 2010 from Excel 2003 - Excel - Microsoft Office 1 of 1
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        Recreate your Newsletter Content and Layout within Informz (Workshop) Monica Capogna and Dan Reade Exercise: Creating two types of Story Layouts 1. Creating a basic story layout (with title and content)    
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        O UTLOOK 2003 HELP SHEET MAIL Opening the program At Work Double-click the icon on your desktop. Or click the Start button. If this icon is displayed, click on it. If it is not displayed, click Start,    

    
        More information 
    




    
        How to Mail Merge PDF Documents
    

    
        
        How to Mail Merge PDF Documents A step-by-step guide to creating personalized documents Table of Contents What is a mail merge?... 2 What do I need to start?... 2 Step 1: How to create a PDF document?...    
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        Mastering Lync Meetings cd_mastering_lync_meetings_v2 1 8/25/2014 Course Title Contents Overview of scheduled Online Lync meetings... 3 General Best Practices... 3 Scheduling the meeting... 4 Recurring    

    
        More information 
    




    
        Working with the Ektron Content Management System
    

    
        
        Working with the Ektron Content Management System Table of Contents Creating Folders Creating Content 3 Entering Text 3 Adding Headings 4 Creating Bullets and numbered lists 4 External Hyperlinks and e    
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        How to Build a Form in InDesign CS5 Subject Descriptors: InDesign CS5, Text Frame, Field, Form, Tabs, Leader, Radio, Buttons, New Layer, Export, PDF, Recognition, Highlight Application (Version): Adobe    
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        Outlook XP Email Only Table of Contents OUTLOOK XP EMAIL 5 HOW EMAIL WORKS: 5 POP AND SMTP: 5 TO SET UP THE POP AND SMTP ADDRESSES: 6 TO SET THE DELIVERY PROPERTY: 8 STARTING OUTLOOK: 10 THE OUTLOOK BAR:    
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        Petrel TIPS&TRICKS from SCM Knowledge Worth Sharing Building Montages in Petrel Most Petrel projects require display maps to be made for presentations; either for partners or peers. This TIPS&TRICKS provides    
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        Cal Answers Analysis Training Part III Advanced OBIEE - Dashboard Reports University of California, Berkeley March 2012 Table of Contents Table of Contents... 1 Overview... 2 Remember How to Create a Query?...    
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        Introduction to dobe Acrobat XI Pro Introduction to Adobe Acrobat XI Pro is licensed under the Creative Commons Attribution-NonCommercial-NoDerivatives 4.0 International License. To view a copy of this    

    
        More information 
    




    
        Microsoft Office PowerPoint 2007. Lyon County Schools
    

    
        
        Microsoft Office PowerPoint 2007 Lyon County Schools Accessing 2007 Programs Button When you open any of the 2007 Microsoft Office programs, you ll notice THE button (with the Microsoft logo on it). The    
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        What s New in SMART Board Software 9.0 for Windows Operating Systems If you ve used SMART Board software before, you ll notice many changes in version 9.0. In this document, we ll introduce version 9.0    
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        Creating a Basic Survey Using Qualtrics Clayton State University has purchased a campus license to Qualtrics. Both faculty and students can use Qualtrics to create surveys that contain many different types    
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        In This Guide Microsoft Word 2010 looks very different, so we created this guide to help you minimize the learning curve. Read on to learn key parts of the new interface, discover free Word 2010 training,    
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        Dreamweaver and Fireworks MX Integration Brian Hogan This tutorial will take you through the necessary steps to create a template-based web site using Macromedia Dreamweaver and Macromedia Fireworks. The    
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        Advanced Form Customization APPENDIX E If you know exactly how you want your business forms to look and don t mind detail work, you can customize QuickBooks forms however you want. With QuickBooks Layout    
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        RemoteWare Software Manager Client User s Guide Version 2.0 RemoteWare Software Manager Client User s Guide Version 2.0 This document was prepared to assist licensed users of RemoteWare by XcelleNet, Inc.;    
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        Use ArcGIS Online to Manage Your Own Custom Map Gallery By Keith Mann, Esri Start customizing the template by changing the graphics and the web page title. Wouldn t it be great if you could create a dynamic    
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        1 FAQ Nothing Happens When I Print? How Do I Search? How Do I Find Feature Information? How Do I Print? How can I Email A Map? How Do I See the Legend? How Do I Find the Coordinates of a Location? How    
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        Crop and Frame Your Photos Paint Shop Pro s crop tool gives you total control over your photo compositions. Cropping allows you to turn busy portraits into professional prints. And when you have a nicely    
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        Step 2: Headings and Subheadings This PDF explains Step 2 of the step-by-step instructions that will help you correctly format your ETD to meet UCF formatting requirements. Step 2 shows you how to set    
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        Mail Using Categories 1. Select the message that for the category. 2. Select the appropriate category. 3. The category color displays next to the message. Renaming Categories 1. Select a message. 2. Select    
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        Working with sections in Word Have you have ever wanted to create a Microsoft Word document with some pages numbered in Roman numerals and the rest in Arabic, or include a landscape page to accommodate    
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        Hands-on Guide FileMaker Pro Using FileMaker Pro with Microsoft Office Table of Contents Introduction... 3 Before You Get Started... 4 Sharing Data between FileMaker Pro and Microsoft Excel... 5 Drag and    
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        That CAD Girl J ennifer dib ona Website: www.thatcadgirl.com Email: thatcadgirl@aol.com Phone: (919) 417-8351 Fax: (919) 573-0351 Autocad Model Space and Paper Space Model Space vs. Paper Space Initial    
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        Basic tutorial for Dreamweaver CS5 Creating a New Website: When you first open up Dreamweaver, a welcome screen introduces the user to some basic options to start creating websites. If you re going to    
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        Create an Art Collage Anyone with children knows how much art they bring home from school everyday, those backpacks full of art add up fast. Now, you don t have to part with a single precious piece or    
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        Microsoft Publisher 2010: Web Site Publication Application Note Team 6 Darci Koenigsknecht November 14, 2011 Table of Contents ABSTRACT... 3 INTRODUCTION... 3 KEYWORDS... 3 PROCEDURE... 4 I. DESIGN SETUP...    
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        ADMINISTRATORS GUIDE EPISUITE 6 A quick tutorial on how to set up and implement Episuite Software created by IDentiphoto Specialists in IDentification 1810 Joseph Lloyd Pkwy. Willoughby, OH 44094 Phone:    
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        Using Adobe Acrobat X Professional Adobe Acrobat X Professional is the version of Acrobat that Publishing uses. This chapter covers the following topics: Configuring Adobe Acrobat Distiller X Creating    
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        Business Objects InfoView Quick-start Guide Last Modified: 10/28/2015 The latest PDF version of this document can be found at: http://www.calpolycorporation.com/docs/finance/boeinfoviewquickstart.pdf What    
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        4HONLINE Sending Emails and Texts Created: October 23, 2013 Revised: October 24, 2013 (Corrected document title and added texting on page 3.) Revised: November 4, 2014 (Update to 4HOnline changed screens    
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        In this chapter Find out why it s important to put finishing touches on a slide show Learn how to use the slide sorter Explore the use of slide transitions Learn how to change slide color schemes and backgrounds    
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        Learn how to create web enabled (browser) forms in InfoPath 2013 and publish them in SharePoint 2013. InfoPath 2013 Web Enabled (Browser) forms InfoPath 2013 Web Enabled (Browser) forms Creating Web Enabled    
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        Week 5 Cookbook: GIS Tutorial Chapter 2 GIS Map Design: Choropleth Maps Week 5 Overview 1. Introducing Choropleth Maps 2. Introducing Map Elements 3. First Hands-On Example 4. Your Turn: GIS Tutorial Chapter    
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        Printing to the Poster Printer Document size The HP Design Jet Z3100ps uses a roll of paper that is 36 wide, however it does not print all the way to the edge of the paper (known as a bleed ). One dimension    

    
        More information 
    




    
        7.0 BW Budget Formulation Report Tips and Tricks
    

    
        
        7.0 BW Budget Formulation Report Tips and Tricks Sections: A. Variables Entry Options for Entering Selections B. Variables Entry Screen Personalization and Screen Variants C. Bookmarks D. Print in PDF    
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        Hypercosm Studio www.hypercosm.com  Hypercosm Studio Guide 3 Revision: November 2005 Copyright 2005 Hypercosm LLC All rights reserved. Hypercosm, OMAR, Hypercosm 3D Player, and Hypercosm Studio are trademarks    
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        1 Chapter 4: In its most basic form, a website is a group of files stored in folders on a hard drive that is connected directly to the internet. These files include all of the items that you see on your    
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        CHAPTER Staying Organized with the Outlook Journal In this chapter Using Outlook s Journal 362 Working with the Journal Folder 364 Setting Up Automatic Email Journaling 367 Using Journal s Other Tracking    
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        WOWS of Word Office brings a whole new basket of bells and whistles for our enjoyment. The whistles turn to wows. gfruth@wm.edu Templates Click on the Office Button PDF and select New. You can now change    
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        Updates to Graphing with Excel NCC has recently upgraded to a new version of the Microsoft Office suite of programs. As such, many of the directions in the Biology Student Handbook for how to graph with    
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        Adobe Acrobat 6.0 Professional Manual Adobe Acrobat 6.0 Professional Manual Purpose The will teach you to create, edit, save, and print PDF files. You will also learn some of Adobe s collaborative functions,    
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        In this chapter Learn how to get around in the Open File dialog box. See how to navigate through drives and folders and display the files in other folders. Learn how to search for a file when you can t    
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        SMART NOTEBOOK 10 Instructional Technology Enhancing ACHievement TABLE OF CONTENTS SMART Notebook 10 Themes... 3 Page Groups... 4 Magic Pen... 5 Shape Pen... 6 Tables... 7 Object Animation... 8 Aligning    
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        Guide to PDF Publishing Alibre Design 9.2 Copyrights Information in this document is subject to change without notice. The software described in this document is furnished under a license agreement or    
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        1 Adobe InDesign 2.0 Extensible Markup Language (XML) is a text file format that lets you reuse content text, table data, and graphics in a variety of applications and media. One advantage of using XML    

    
        More information 
    




    
        So you say you want something printed...
    

    
        
        So you say you want something printed... Well, that s great! You ve come to the right place. Whether you re having us design and edit your work, or you fancy yourself a designer and plan to hand over your    
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        VERSION 3.0 MAC USER GUIDE TABLE OF CONTENTS Introduction... 5 What s New?... 5 What This Guide Is Not... 6 Getting Started... 7 Activating... 7 Activate Via the Internet... 7 Activate Via Email... 7 Upgrading...    
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        Introduction to Microsoft Publisher : Tools You May Need 1. Why use Publisher instead of Word for creating fact sheets, brochures, posters, newsletters, etc.? While both Word and Publisher can create documents    

    
        More information 
    




    
        Intellect Platform - The Workflow Engine Basic HelpDesk Troubleticket System - A102
    

    
        
        Intellect Platform - The Workflow Engine Basic HelpDesk Troubleticket System - A102 Interneer, Inc. Updated on 2/22/2012 Created by Erika Keresztyen Fahey 2 Workflow - A102 - Basic HelpDesk Ticketing System    
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        Ansur Test Executive Users Manual April 2008 2008 Fluke Corporation, All rights reserved. All product names are trademarks of their respective companies Table of Contents 1 Introducing Ansur... 4 1.1 About    
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        CONTENT MANAGER GUIDELINES Content Manager is a web-based application created by Scala that allows users to have the media they upload be sent out to individual players in many locations. It includes many    
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        Working with Tables in Microsoft Word The purpose of this document is to lead you through the steps of creating, editing and deleting tables and parts of tables. This document follows a tutorial format    

    
        More information 
    




    
        Sharing a Screen, Documents or Whiteboard in Cisco Unified MeetingPlace
    

    
        
        Sharing a Screen, Documents or Whiteboard in Cisco Unified MeetingPlace Release: 7.0 Revision Date: December 9, 2009 1:29 pm This section describes how to use the features in the Cisco Unified MeetingPlace    
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        Microsoft Expression Web Quickstart Guide Expression Web Quickstart Guide (20-Minute Training) Welcome to Expression Web. When you first launch the program, you ll find a number of task panes, toolbars,    
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        Mississippi College presents: Microsoft Office Access 2007 Training Course contents Overview: Fast, easy, simple Lesson 1: A new beginning Lesson 2: OK, back to work Lesson 3: Save your files in the format    
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        Mail Chimp Basics Mail Chimp is a web-based application that allows you to create newsletters and send them to others via email. While there are higher-level versions of Mail Chimp, the basic application    
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        MAIL MERGE TUTORIAL (For Microsoft Word 2003-2007 on PC) WHAT IS MAIL MERGE? It is a way of placing content from a spreadsheet, database, or table into a Microsoft Word document Mail merge is ideal for    
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